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WHAT’S A TRAINING DAY?!

Building a game in 8 phases. 

01 - PROJECT & SCENE SETUP 

02 - TANK CREATION & CONTROLS 

03 - CAMERA 

04 - HEALTH 

05 - SHELLS 

06 - SHOOTING 

07 - GAME MANAGERS 

08 - AUDIO 
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OKAY.  
LET’S DO THIS.
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PROJECT SETUP PHASE 1 / 8

1. Install Unity version 5.2 or greater 

2. Download the project from the asset store, 

just search for Tanks tutorial 

3. Import the files from the Asset store package 

SLIDE 1 / 7
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PROJECT SETUP PHASE 1 / 8

1. Use Two by Three layout using the Layout 

drop-down in the upper right  

2. Drag the Project window below the Hierarchy 

3. Set Project window zoom to minimum

SLIDE 2 / 7
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SCENE SETUP PHASE 1 / 8

1. Make sure you have the correct project open 

and you are in an empty scene, if not, go to  
File > New Scene 

2. Save the empty scene to the Scenes folder 

and call it Main

SLIDE 3 / 7
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SCENE SETUP PHASE 1 / 8

1. Delete the Directional Light from the scene 

2. Drag the Level Art prefab from the Project  

panel Prefabs folder into the Hierarchy panel 

3. From the Window menu, open the Lighting 

Panel and dock it with the Inspector

SLIDE 4 / 7
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SCENE SETUP PHASE 1 / 8

1. At the bottom of the panel uncheck Auto 

2. Moving up, uncheck Baked GI 

3. Set Realtime Resolution to 0.5 

4. Change Ambient Source from Skybox to Color 

5. Set the Ambient Color to ( 72, 62, 113 ) 

6. Click Build on the Lighting panel

SLIDE 5 / 7
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SCENE SETUP PHASE 1 / 8

1. Return to the Inspector panel 

2. Change the Position of the Main Camera to 

( -43, 42, -25 ) 

3. Change its Rotation to ( 40, 60, 0 ) 

4. On the Camera component change the 

Projection to Orthographic

SLIDE 6 / 7
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SCENE SETUP PHASE 1 / 8

1. Change Clear Flags from Skybox  
to Solid Color 

2. Change the Background color to  
( 80, 60, 50 ) 

3. Save your scene!

SLIDE 7 / 7
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END OF 
PHASE ONE
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PHASE 1 QUIZ

What colour represents the X axis? 

a) Blue     b) Red     c) Yellow     d) Green 

In which panel can you find a list of all of the game objects in the Scene? 

a) Inspector   b) Project   c) Scene   d) Hierarchy 

If you want to create an instance of a prefab in your scene, you drag the prefab 

from the project panel into either of which two panels? 

a) Inspector or Hierarchy 

b) Inspector or Scene 

c) Scene or Hierarchy 

d) Game or Inspector 
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TANK CREATION PHASE 2 / 8

1. In the Models folder of the Project, find the 

model called Tank and drag it into the 

Hierarchy panel 

2. At the top of the Inspector panel, set the Layer 

of the Tank GameObject to Players 

3. For the Change Layer dialog that appears, 

select No, this object only

SLIDE 1 / 12
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TANK CREATION PHASE 2 / 8

1. Add a Rigidbody component  

2. Expand the Constraints area of the Rigidbody 

3. Under Constraints check Freeze Position for 

the Y axis 

4. Check Freeze Rotation for the X and Z axes

SLIDE 2 / 12
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TANK CREATION PHASE 2 / 8

1. Add a Box Collider component to the  
Tank GameObject 

2. On the Box Collider component change the 

Center to ( 0,  0.85,  0 ) 

3. Also, change the Size to ( 1.5,  1.7,  1.6 )

SLIDE 3 / 12
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TANK CREATION PHASE 2 / 8

1. Add an Audio Source component to the Tank 

GameObject 

2. On the Audio Source component change the 

AudioClip to EngineIdle using the circle-

select button 

3. Also check Loop

SLIDE 4 / 12
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TANK CREATION PHASE 2 / 8

1. Add another Audio Source component  

2. On the second Audio Source component 

uncheck Play On Awake 

3. Select the Prefabs folder in the Project panel 

4. Click and drag the Tank GameObject from 

the Hierarchy to the Project panel 

5. Save the scene!

SLIDE 5 / 12



UNITE 2015

MOVING PHASE 2 / 8

1. From the Prefabs folder drag the DustTrail 

prefab onto the Tank GameObject in the 

Hierarchy to make it a child GameObject 

2. Duplicate the DustTrail so that there are two, 

use Command-D on Mac, Ctrl-D on PC 

SLIDE 6 / 12
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MOVING PHASE 2 / 8

1. Rename one of the child GameObjects from 

DustTrail to LeftDustTrail 

2. Set the Position of LeftDustTrail to ( -0.5, 0, -0.75 ) 

3. Rename the other DustTrail GameObject  
to RightDustTrail 

4. Set the position of RightDustTrail  
to ( 0.5, 0, -0.75 )

SLIDE 7 / 12
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MOVING PHASE 2 / 8

1. In the Scripts/Tank folder, find the 

TankMovement script  

2. Drag and drop it onto the Tank GameObject 

3. Open the TankMovement script using double 

click on the script in the Project view

SLIDE 8 / 12
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MOVING PHASE 2 / 8

Script Checklist 

1. GET THE INPUT 

2. SETUP THE AUDIO 

3. SETUP FORWARD/BACK MOVEMENT 

4. SETUP TURNING

SLIDE 9 / 12
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MOVING PHASE 2 / 8

1. For the Movement Audio variable use the first 

Audio Source component. Drag the name of 

the component and drop it onto the space 

next to Movement Audio 

2. For the Engine Idling variable, click on the 

circle-select button and choose the 

EngineIdle audio clip from the list

SLIDE 10 / 12
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MOVING PHASE 2 / 8

1. For the Engine Driving variable, click on the 

circle-select button & choose EngineDriving 

2. At the top of the Inspector, apply the changes 

to your Tank prefab by clicking Apply 

3. Save your scene using File > Save 

SLIDE 11 / 12
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MOVING PHASE 2 / 8

1. Press Play and try driving the tank around! 

2. Remember to press Play again to stop  
playing afterwards 

3. Save the scene!

SLIDE 12 / 12
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END OF 
PHASE TWO
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PHASE 2 QUIZ

Which of these is a component used to play sounds in a game? 

a) Audio Source   b) Audio Clip   c) Audio Listener   d) Audio Mixer 

What variable type do we use to store Rotation? 

a) Integer   b) Vector3   c) Transform   d) Quaternion 

After the following line of code is run, what will the Rigidbody’s position be? 

m_Rigidbody.MovePosition(new Vector3(0, 0, 10)); 

a) Ten units from it’s previous position in the Z axis 

b) At the origin 

c) At (0, 0, 10) 

d) This won’t move the Rigidbody 
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CAMERA PHASE 3 / 8

1. Use the Create menu in the Hierarchy to 

create an Empty GameObject by choosing 

Create Empty 

2. Rename the empty GameObject to 

CameraRig

SLIDE 1 / 33
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CAMERA PHASE 3 / 8

1. Reset its Position by clicking the Cog icon 

next to its Transform component and 

choosing Reset Position 

2. Set the Rotation of the CameraRig  
to ( 40,  60,  0 )

SLIDE 2 / 33
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CAMERA PHASE 3 / 8

1. In the Hierarchy drag the Main Camera 

GameObject onto the CameraRig 

GameObject to make it a child 

2. Set the Position of the Main Camera  
to ( 0,  0,  -65 ) 

3. Make sure the Rotation of the Main Camera  
is ( 0,  0,  0 )

SLIDE 3 / 33
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CAMERA PHASE 3 / 8

• What is a frustum? 

SLIDE 4 / 33
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CAMERA PHASE 3 / 8

• What is a frustum? 

SLIDE 5 / 33
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CAMERA PHASE 3 / 8

• What is a frustum? 

SLIDE 6 / 33
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CAMERA PHASE 3 / 8

• What is an orthographic camera? 

SLIDE 7 / 33
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• What is an orthographic camera? 

SLIDE 8 / 33



UNITE 2015

CAMERA PHASE 3 / 8

• What is an orthographic camera? 

SLIDE 9 / 33
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• What is an orthographic camera? 

SLIDE 10 / 33
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Remember: We Zoom by setting the size. 

CAMERA PHASE 3 / 8

• What is an orthographic camera’s size? 

SLIDE 11 / 33
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CAMERA PHASE 3 / 8

• What is a camera’s aspect? 

SLIDE 12 / 33

1080p means a screen is 1920 x 1080 pixels 

1920 x 1080 is an aspect ratio of 16:9 

To find the aspect we divide - the aspect of 16:9 is 16 / 9 = 1.778
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CAMERA PHASE 3 / 8

SLIDE 13 / 33

What should our camera do?
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CAMERA PHASE 3 / 8

• Follow the tanks

SLIDE 14 / 33
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CAMERA PHASE 3 / 8

• Follow the tanks 

• Re-size (Zoom) to fit the tanks on screen

SLIDE 15 / 33

What should our camera do?
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CAMERA PHASE 3 / 8

SLIDE 16 / 33
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CAMERA PHASE 3 / 8

1. Find the Scripts/Camera folder 

2. Drag and drop the Camera Control script 

onto the CameraRig GameObject in the 

Hierarchy 

3. Double click on the script name on the 

Component to open it 

SLIDE 17 / 33
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CAMERA PHASE 3 / 8

FOLLOWING THE TANKS

SLIDE 18 / 33

I. Find the Average 
of the Tanks’ positions 

II. Set the CameraRig 
to that position each 
frame
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CAMERA PHASE 3 / 8

Following the tanks is easy! 

What about zoom?

SLIDE 19 / 33
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CAMERA PHASE 3 / 8

SLIDE 17 / 55

SIZE

SIZE X ASPECT
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CAMERA PHASE 3 / 8

SLIDE 17 / 55

ASPECT

DISTANCE = SIZE
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CAMERA PHASE 3 / 8

1. Select the CameraRig GameObject  

2. Drag the Tank GameObject onto the name of 

the public variable Targets on the Camera 
Control (script) component

SLIDE 32 / 33
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CAMERA PHASE 3 / 8

1. Press Play and give your game a test 

2. Stop Play afterwards! (not pause) 

3. Save the scene! 

SLIDE 33 / 33
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END OF 
PHASE THREE
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PHASE 3 QUIZ

In a game object’s Transform component on the Inspector,  
what does the property ‘Position’ display? 

a) The world space position 

b) The local space position 

c) The position relative to it’s children 

d) The relationship between it’s Scale and it’s Euler angles rotation 

With an orthographic camera, which of the following would have the effect of 

zooming in? 

a) Move the camera’s position closer 

b) Decreasing the camera’s orthographic size 

c) Increasing the camera’s orthographic size 

d) Increasing the camera’s aspect
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PHASE 3 QUIZ
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HEALTH PHASE 4 / 8

1. Make sure the transform toggle above the 

Scene View is set to Pivot and not Center 

2. Create a Slider using 
GameObject > UI > Slider  
from the top menu 

SLIDE 1 / 14



UNITE 2015

HEALTH PHASE 4 / 8

1. Select the EventSystem GameObject 

2. On the Standalone Input Module component 

change the Horizontal Axis to HorizontalUI 

3. Set the Vertical Axis to VerticalUI 

4. Select the Canvas GameObject 

5. On the Canvas Scaler component change 

the Reference Pixels per Unit to 1

SLIDE 2 / 14
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HEALTH PHASE 4 / 8

1. On the Canvas component of the Canvas 

GameObject change the Render Mode to 

World Space

SLIDE 3 / 14
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HEALTH PHASE 4 / 8

1. In the Hierarchy drag Canvas onto the Tank 

GameObject to make it a child 

2. Select the Canvas, on the RectTransform 

component change Position to ( 0, 0.1, 0 ) 

3. Change the Width and Height to 3.5 

4. Change the Rotation to ( 90, 0, 0 ) 

5. Save the scene!

SLIDE 4 / 14
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HEALTH PHASE 4 / 8

1. Expand the Canvas and all of it’s children by Alt-

clicking the arrow to its left 

2. Select the HandleSlideArea and delete it 

3. Multi-Select Slider, Background, Fill Area and Fill 

4. Click on the Anchor Presets drop-down and  
Alt-Click on the lower-right preset to stretch the 

GameObjects over the entire canvas

SLIDE 5 / 14
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HEALTH PHASE 4 / 8

1. Select the Slider GameObject  

2. On the Slider component uncheck Interactable 

3. Change the Transition to None 

4. Change the Max Value and Value to 100

SLIDE 6 / 14
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HEALTH PHASE 4 / 8

1. Rename the Slider to HealthSlider 

2. Select the Background GameObject 

3. On the Image component use the circle-

select to change the Source Image  
to HealthWheel 

4. Click on Color to change the alpha (A) to 80

SLIDE 7 / 14
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HEALTH PHASE 4 / 8

1. Select the Fill GameObject 

2. Set the SourceImage on the Image 

component to HealthWheel 

3. Change the alpha (A) to 150 

4. Change the Image Type to Filled 

5. Change the Fill Origin to Left 

6. Uncheck Clockwise

SLIDE 8 / 14
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HEALTH PHASE 4 / 8

1. In the Scripts/UI folder, find the 

UIDirectionControl script  

2. Select the HealthSlider GameObject and add 

the UIDirectionControl script to it 

3. Select the Tank GameObject and click Apply 

at the top of the Inspector to update the prefab 

SLIDE 9 / 14
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HEALTH PHASE 4 / 8

1. Find the TankExplosion prefab in the Prefabs 

folder. Drag it into the Hierarchy 

2. Add an AudioSource component to the 

TankExplosion GameObject 

3. Assign the TankExplosion Audio Clip to the 

Audio Source, and uncheck Play On Awake

SLIDE 10 / 14
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HEALTH PHASE 4 / 8

1. On the TankExplosion GameObject, click Apply to 

update the prefab 

2. Delete the TankExplosion prefab from the Hierarchy 

3. Find the TankHealth script in the Scripts/Tank folder. 

Drag it onto the Tank GameObject 

4. Double-click on the TankHealth script to open it for 

editing

SLIDE 11 / 14
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HEALTH PHASE 4 / 8

Script Checklist 

1. SETUP TANK DAMAGE 

2. UPDATE UI BASED ON TANK HEALTH 

3. TANK DEACTIVATION

SLIDE 12 / 14
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HEALTH PHASE 4 / 8

1. Select the Tank GameObject  

2. Drag and drop the HealthSlider GameObject from 

the Hierarchy onto the HealthSlider public variable 

of the TankHealth script 

3. Do the same with the Fill GameObject for the Fill 

Image public variable 

4. Drag & Drop the TankExplosion prefab onto the 

Explosion Prefab public variable

SLIDE 13 / 14
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HEALTH PHASE 4 / 8

1. At the top of the Inspector, Apply the changes 

to the Tank prefab. 

2. Save the scene!

SLIDE 14 / 14
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END OF 
PHASE FOUR
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PHASE 4 QUIZ

What component do all UI game objects have that most game objects do not? 

a) Canvas   b) Canvas Scaler   c) Rect Transform   d) Event System 

To switch off a Game Object, which code syntax is correct? 

a) gameObject.SetActive(false);
b) gameObject.SetEnabled(false);
c) gameObject.enabled = false;
d) gameObject.activated = false;

How do you stop the player from being able to drag to adjust the value of a slider? 
a) Delete the Handle Slide Area game object 
b) Change the Slider’s Transition to None 
c) Delete the Background game object 
d) Uncheck Interactable on the Slider component
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PHASE 4 QUIZ
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1. Find the model named Shell in the Models 

folder.  Drag it into the Hierarchy 

2. Add a Capsule Collider component to the 

Shell GameObject 

3. Check Is Trigger on the Capsule Collider

SLIDE 1 / 11
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1. Set the Direction to Z-Axis 

2. Change the Center of the Capsule Collider  
to ( 0, 0, 0.2 ) 

3. Change the Radius of the Capsule Collider  
to 0.15 and the Height to 0.55 

4. Add a Rigidbody component to the Shell 

GameObject

SLIDE 2 / 11
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1. Find the prefab ShellExplosion in the Prefabs 

folder. Drag it onto the Shell GameObject to 

make it a child 

2. Add an AudioSource component to the 

ShellExplosion GameObject

SLIDE 3 / 11



UNITE 2015

SHELLS PHASE 5 / 8

1. Use the circle-select to set AudioClip of the 

AudioSource to ShellExplosion 

2. Uncheck Play On Awake on the AudioSource

SLIDE 4 / 11
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1. Reselect the Shell GameObject 

2. Add a Light Component

SLIDE 5 / 11
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1. In the Scripts/Shell folder, find the 

ShellExplosion script, drag it onto the Shell 

GameObject in the Hierarchy 

2. Double click on the ShellExplosion script to 

open it for editing

SLIDE 6 / 11
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SLIDE 7 / 11
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SLIDE 8 / 11
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Script Checklist 

1. FIND TANKS TO AFFECT 

2. APPLY DAMAGE TO AFFECTED TANKS 

3. APPLY FORCE TO AFFECTED TANKS 

4. PLAY SOUND AND PARTICLE EFFECTS 

5. TIDY REMAINING GAME OBJECTS

SLIDE 9 / 11
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1. With the Shell GameObject still selected drag the child 

GameObject called ShellExplosion onto the Explosion 

Particles and Explosion Audio public variables 

2. Set the Tank Mask public variable to Players 

3. Drag the Shell GameObject to the Prefabs folder in the 

Project panel to save it as a prefab

SLIDE 10 / 11
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SHELLS PHASE 5 / 8

1. Delete the Shell GameObject from the 

Hierarchy 

2. Save the scene!

SLIDE 11 / 11
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END OF 
PHASE FIVE
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PHASE 5 QUIZ

What type does the Physics.OverlapSphere function return? 

a) Collider[]  b) Transform[]  c) Rigidbody[]   d) GameObject[]

What must be changed in the Inspector of a Capsule Collider for  
OnTriggerEnter to be called for that collider? 

a) A trigger material must be used 

b) The center must be offset 

c) The radius must be sufficiently small that it is less than the offset’s distance 

d) The Is Trigger checkbox must be checked 

Why is there an f after some numbers in code? 

a) The f replaces the decimal place when writing numbers less than 1 

b) The f stands for figure and tells the compiler to keep the number constant 

c) The f stands for forbidden, telling the compiler never to use them. like ever. 

d) The f stands for float, and tells the compiler to treat it as a floating point number
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1. Select the Tank GameObject in the Hierarchy 

2. Right-click on the Tank GameObject and 

choose Create Empty 

3. Rename the child GameObject to FireTransform 

4. Set the Position of FireTransform to ( 0, 1.7, 1.35 ) 

5. Set the Rotation of FireTransform to ( 350, 0, 0 )

SLIDE 1 / 12
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1. Right-click on Canvas in the Hierarchy and choose 

UI > Slider 

2. Rename the new Slider to AimSlider 

3. Alt-click the arrow to the left of AimSlider to Expand 

the GameObject so that its children are visible in the 

Hierarchy 

4. Delete the Background and Handle Slide Area 

GameObjects

SLIDE 2 / 12
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1. Reselect the AimSlider GameObject and find 

the Slider component in the Inspector 

2. Uncheck Interactable 

3. Set the Slider component’s Transition to None 

4. Set Direction to Bottom To Top 

5. Set the Min Value to 15 

6. Set the Max Value to 30

SLIDE 3 / 12
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1. Multi-Select the AimSlider and Fill Area 

GameObjects 

2. In their Rect Transform components click on 

the Anchor Presets drop down and alt-click 

the lower-right option to Stretch the 

GameObjects vertically and horizontally over 

the canvas

SLIDE 4 / 12
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1. Expand Fill Area and select the Fill 

2. On the Rect Transform, set Height to 0 to 

remove offsets from the parent Rect 

3. On the Fill GameObject, for the Image 

component use the circle-select button to 

change the Source Image to Aim Arrow

SLIDE 5 / 12



UNITE 2015

SHOOTING PHASE 6 / 8

1. Select the AimSlider GameObject 

2. Use the Rect Tool (T) to drag the Left / Right bounds 

of the Rect so that its as narrow as the Tank 

3. Drag the AimSlider forward & up from the Tank, then 

drag out the top edge to make a longer slider 

4. Our values are (1,  -9,  -1,  1,  3)

SLIDE 6 / 12
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1. Find the TankShooting script in the Scripts/

Tank folder 

2. Drag and drop it onto the Tank GameObject 

in the Hierarchy 

3. Double-click on the TankShooting script in the 

Project panel to open it for editing

SLIDE 7 / 12
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Script Checklist 

1. CHECK FIRE BUTTON STATE 

2. UPDATE FIRING CHARGE 

3. INSTANTIATE SHELL WHEN BUTTON RELEASED  
OR AT MAXIMUM CHARGE

SLIDE 8 / 12
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1. Find the Shell prefab in the Prefabs folder and 

drag it onto the Shell public variable 

2. Find the FireTransform child GameObject and 

drag it onto the FireTransform public variable 

3. Find the AimSlider GameObject which is a 

child of the Canvas GameObject.  
Drag it onto the AimSlider public variable

SLIDE 9 / 12
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1. Find the second Audio Source on the Tank 

GameObject.  
This is the one with no clip assigned as well as 

Loop and Play On Awake unchecked 

2. Drag and drop the name of this Audio Source 

onto the Shooting Audio public variable of the 

TankShooting script

SLIDE 10 / 12
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1. Use the circle-select button to set the 

Charging Clip variable to ShotCharging 

2. Likewise use the circle-select button to set the 

Fire Clip variable to ShotFiring 

3. Ensure the Tank GameObject is still selected  
and click Apply at the top of the Inspector 
to update the prefab

SLIDE 11 / 12
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1. The Tank is now finished! Give it a test! 

2. MAKE SURE THAT ALL CHANGES ARE APPLIED  
to the Tank prefab by pressing Apply at the 

top of the Tank GameObject’s Inspector 

3. Delete the Tank GameObject from the scene 

4. Save the scene!

SLIDE 12 / 12
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PHASE 6 QUIZ

What component is used to create the visual parts of a UI slider? 

a) Image  b) Sprite  c) Slider  d) It must be done with a custom script 

Which of the following functions returns true whenever an input button is held? 

a) Input.GetButton
b) Input.GetButtonDown
c) Input.GetButtonUp
d) Input.GetAxis

A Rigidbody’s velocity is of which type? 

a) float 

b) Transform 

c) Vector3 

d) Velocity
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1. Create two empty GameObjects by going to 

the Create menu in the Hierarchy and 

selecting Create Empty - twice! 

2. Rename the empty GameObjects to 

SpawnPoint1 and SpawnPoint2

SLIDE 1 / 25
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1. Position SpawnPoint1 at ( -3, 0, 30 ) 

2. Set the Rotation of SpawnPoint1 to ( 0, 180, 0 ) 

3. Position SpawnPoint2 at ( 13, 0, -5 ) 

4. Ensure the Rotation of SpawnPoint2 is ( 0,0,0 )

SLIDE 2 / 25
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1. In the Inspector, to the left of the 

GameObject’s name is an icon for the 

GameObject’s gizmo. Change the gizmo for 

SpawnPoint1 to the blue name tag 

2. Change the gizmo for SpawnPoint2 to the red 

name tag

SLIDE 3 / 25
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1. Go to GameObject > UI > Canvas  
to create a new canvas GameObject 

2. Rename it MessageCanvas 

3. On the Scene view, click on the 2D button to 

enable 2D mode 

4. With the MessageCanvas selected and the 

mouse cursor over the Scene view press F to frame 

the selected MessageCanvas

SLIDE 4 / 25
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1. Right-click MessageCanvas and choose  
UI > Text to create a Text GameObject as a 

child of the MessageCanvas

SLIDE 5 / 25
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1. On the RectTransform component of the Text 

GameObject set the Anchors for the X and Y 

axes to have a Min of 0.1 and a Max of 0.9 

2. Set the Left, Right, Top, Bottom and Pos Z to 0

SLIDE 6 / 25
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1. On the Text component set the Text to be 

“TANKS!” 

2. Use the circle-select button to change the 

Font to BowlbyOne-Regular 

3. Change the Alignment to centre and middle

SLIDE 7 / 25
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1. Enable Best Fit 

2. Set the Max Size to 60 

3. Set the Color to White ( 255, 255, 255, 255 )

SLIDE 8 / 25



UNITE 2015

MANAGERS PHASE 7 / 8

1. Click the Add Component button and type 

Shadow in the search bar 

2. Click on the Shadow component in the list to 

add it to the Text GameObject 

3. Set Effect Color to Brown ( 114, 71, 40, 128 ) 

4. Set the Effect Distance to ( -3, -3 ) 

5. Disable 2D Mode on the Scene View

SLIDE 9 / 25
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1. Select the CameraRig GameObject 

2. Go to Edit > Frame Selected (Shortcut - F) 

3. On the CameraControl (script) component, 

set the Targets array to a size of 0 by typing 

into the Size property, and pressing Return 

4. Double click on the CameraControl script to 

open it for editing

SLIDE 10 / 25
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1. Click the Create button on the Hierarchy and 

choose Create Empty 

2. Rename it GameManager 

3. Find the GameManager script in the Scripts/

Managers folder 

4. Drag it onto the GameManager GameObject to 

add it as a component

SLIDE 11 / 25
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1. Drag the CameraRig GameObject from the 

Hierarchy onto the Camera Control public variable 

of the GameManager (script) component 

2. Expand the MessageCanvas GameObject  

3. Drag the Text child GameObject onto the  
Message Text public variable of the Game Manager 

4. Find the Tank prefab in the Prefabs folder and drag 

it onto the Tank Prefab public variable

SLIDE 12 / 25
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1. Expand the Tanks array on the 

GameManager script, set the Size to 2 

2. Expand Element 0, change the Player Color 

to Blue ( 42, 100, 178 ) 

3. Drag the SpawnPoint1 GameObject from the 

Hierarchy onto the Spawn Point variable 
of Element 0 in the Tanks array

SLIDE 13 / 25
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1. Expand Element 1 and change the Player 

Color to Red ( 229, 46, 40 ) 

2. Drag on the SpawnPoint2 GameObject as the 

Spawn Point of Element 1

SLIDE 14 / 25
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SLIDE 15 / 25

Game Manager

TANK MANAGER

STRUCTURE

INITIALIZATION

SPAWN ALL TANKS 

SET CAMERA TARGETS 

RUN GAME STATES 

ROUND STARTING 

ROUND PLAYING 

ROUND ENDING



UNITE 2015

MANAGERS PHASE 7 / 8

SLIDE 16 / 25

Game Manager

TANK MANAGER

SCRIPTS

SHOOTING 

MOVEMENT

VISIBLE ELEMENTS

UI

STRUCTURE
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SLIDE 17 / 25

Game Manager

TANK MANAGER TANK MANAGER TANK MANAGER

etc

SCRIPTS UI

PLAYER 1 PLAYER 2 ETC

SCRIPTS UI SCRIPTS UI
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SLIDE 18 / 25

GAME MANAGER

Start()

Use array of TankManagers to spawn tanks

Set the CameraControl script Targets array

Start the GameLoop() Coroutine
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1. Double click the GameManager script to open it 

2. Double click the TankManager script to open it 

SLIDE 19 / 25
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SLIDE 20 / 25

GAME MANAGER GameLoop()

RoundStarting()

RoundPlaying()

RoundEnding()

wait, then..

wait, then..
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SLIDE 21 / 25

COROUTINES

void MyFunction()

{

}
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COROUTINES

IEnumerator MyCoroutine()

{

yield

}



UNITE 2015

MANAGERS PHASE 7 / 8

SLIDE 23 / 25

COROUTINES
IEnumerator MyCoroutine()
{

while(){

yield

}
}
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SLIDE 24 / 25

GAME MANAGER

GameLoop()

TANK MANAGER
Reset all tanks

RoundStarting

Round Playing

Round Ending

Enable all Tank Controls

Empty Message UI

Wait for One Tank Left

DisableControl() 
(Cannot Move / Shoot, UI off)

Reset() 

(De/Reactivate / Position)

EnableControl() 
(Can Move / Shoot, UI on)

Disable all Tank Controls
Set Camera Pos & Size
Increment Round number
Set Message UI

Clear existing & get round winner

Check for Game Winner

Calculate Message UI & Show

Disable all Tank Controls
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1. Save the scene! 

2. Grab a neighbour and give it a test!

SLIDE 25 / 25
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PHASE 7 QUIZ

Which attribute can be placed before a class declaration to make it’s properties 

appear in the Inspector panel? 

a) ShowInInspector 

b) HideInInspector 

c) Serializable 

d) ShowInfo 

What type is commonly returned by a function that will be used as a co-routine? 

a) IEnumerator 

b) IEnumerable 

c) void 

d) Interface 

What component does the UI system to display text? 

a) String  b) Message  c) Text  d) WordRenderer
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1. With the GameManager GameObject selected, 

click the Add Component button and choose 

Audio > Audio Source. 

2. Use the circle-select button to set the Audio Clip to 

BackgroundMusic 

3. Check Loop

SLIDE 1 / 12
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1. Right click on the empty AudioMixers folder 

and choose Create > Audio Mixer 

2. Rename it MainMix 

3. Go to Window > Audio Mixer

SLIDE 2 / 12
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1. Use the + icon above the Groups hierarchy to 

add a child of the Master group 

2. Name the new group Music 

3. Reselect the Master group and create 

another group as its child 

4. Rename this group SFX

SLIDE 3 / 12
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1. Reselect the Master group and create a third 

child group 

2. Rename the last group Driving 

3. Make sure they are all children of the Master 

group

SLIDE 4 / 12
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1. Select the Tank prefab in the Prefabs folder 

2. For the First Audio Source use the circle-

select button to set its Output to the Driving 

group of the MainMix audio mixer 

3. For the Second Audio Source use the circle-

select to set its Output to the SFX group of the 

MainMix audio mixer

SLIDE 5 / 12
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1. Find the Shell prefab in the Prefabs folder. 

Expand it so that you can see its children. 

2. Select the ShellExplosion child 

3. Set the Output for the AudioSource on the 

ShellExplosion child to the SFX group of the 

MainMix audio mixer

SLIDE 6 / 12
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1. In the Hierarchy select the GameManager 

GameObject 

2. Set the Output for the Audio Source to the 

Music group of the MainMix audio mixer 

3. Select the TankExplosion prefab in the Project, 

set its Audio Source output to the SFX group 

of the MainMix audio mixer

SLIDE 7 / 12
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1. Return to the Audio Mixer Window 

2. Make sure you have MainMix selected 

3. Select the Music group of MainMix 

4. Set its Attenuation to -12 using the fader 

5. Select the Driving group of MainMix 

6. Change its Attenuation to -25

SLIDE 8 / 12
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1. Reselect the Music group 

2. In the Inspector click the Add Effect button 

and choose Duck Volume

SLIDE 9 / 12
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1. Select the SFX group 

2. Click the Add Effect button and  
choose Send effect 

3. For the Send effect set Receive  
to Music\Duck Volume 

4. Change the Send Level to 0db (full)

SLIDE 10 / 12
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1. Reselect the Music group 

2. For the Duck Volume effect change the 

Threshold to -46 

3. Change the Ratio to 250 

4. Change the Attack Time to 0

SLIDE 11 / 12
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1. Save the scene! 

2. Your game is complete! It’s Play Time!

SLIDE 12 / 12
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PHASE 8 QUIZ

What is the name of the window to display the flow of Audio signals? 

a) Signal  b) Audio Source  c) Audio Mixer d) Funkatron 

What does the ducking audio effect do? 

a) pauses and plays audio sources based on pitch 

b) lower the attenuation of an audio group based on the attenuation of another 

c) it is used to send messages to custom components based on the time of a clip 

d) it is used as a trigger for the anatidae effect 

How awesome have you all been today? 

a) alright I guess 

b) not bad 

c) pretty, pretty good 

d) very
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